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LEARNING GOALS

· The student should be able to state what is meant by the transit of a planet.

· The student should be able to describe what a transit looks like from earth.

· The student should be able to state roughly how frequent transits of Venus and Mercury are. 

· The student should be able to explain why transits of inner planets were important to astronomers in the past.
· The student should be able to describe where the telescopes were located that took the pictures used to analyze the transits of Venus and Mercury.
· The student should be able to state what is meant by parallax and how it depends on the distance of the object and the separation of observers.

· The student should develop an appreciation for the technique of determining the distance to the sun from measurements of the position of Venus or Mercury during transit.
· The student should develop an appreciation for the difficulty of turning images into meaningful scientific information.

PROCEDURAL OBJECTIVES

   If you learn to……

· Use CLEA software to display CCD images of the Sun during transits of Venus and Mercury taken by the GONG Project cameras.

· Measure the positions of the planetary silhouette on the pictures.

· Understand the relation between the x and y positions measured on the images and a graph of the path of the transit across the sun.
· Recognize that the paths as seen from different observatories are different.
· Recognize why the observations from the northernmost observatory appear to cross the sun further south.
· Understand how parallax can be used to calculate distance.
    You should be able to……

· Select a series of images with planetary silhouettes suitable for measurement.

· View an animation of the images showing the path of the transit silhouetted against the Sun.

· Devise a procedure for determining the distance of Venus
· Knowing the distance of Venus, calculate the distance to the sun.

· Understand the difficulties of this method and appreciate what modern methods have superseded it.

USEFUL TERMS YOU SHOULD REVIEW IN YOUR TEXTBOOK AND IN THIS MANUAL

	Angle
	Astronomical Unit
	Baseline
	Cartesian (X,Y) Coordinates
	Celestial Coordinates
	Declination

	Degrees, Minutes, Seconds
	Inferior Planet
	Latitude
	Longitude
	Orbit
	Parallax

	Superior Planet
	Radian
	Right Ascension
	Solar Diameter
	Solar Radius
	Terrestrial Coordinates

	Transit
	Universal Time
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This exercise illustrates the phenomenon of transits. A transit of a planet occurs when a planet passes directly between the earth and the sun and we see the dark silhouette of the planet move across the face of the sun.  The inferior planets, Venus and Mercury, accordingly, are the planets for which we see transits. While transits of Mercury are relatively common, occurring once or twice every decade, transits of Venus are extremely rare, occurring less than twice a century.  The first transit of Venus ever observed occurred in 1639, and since then, only 5 transits of Venus have occurred, the latest in 2004.   The next transit of Venus occurs June 6, 2012, and then not again until 2117. 
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Despite being so rare, transits of Venus have played an important role in the history of astronomy. For the Venus transits of 1761, 1769, 1874, and 1882, many governments organized elaborate and expensive expeditions to remote parts of the globe so that astronomers could view the transit from several different sites.   The reason for such interest is that transits of Venus provided a unique opportunity to determine the length of the Astronomical Unit, which is the average distance between the earth and the sun, a fundamental scale in the universe.  We have easier and more precise methods of determining the Astronomical Unit today, but it is instructive to learn how the old methods worked.  In this exercise, using images of the transit of Venus of June 8, 2004, you will be able to determine the length of the Astronomical Unit with the same accuracy as astronomers of the past.  Thanks to digital imaging and modern computer electronics, you will be able to do it without having to spend months at sea and enduring the rigors of life in a strange land.    

Transits of Venus and the Astronomical Unit: A Brief History

With the establishment of the sun-centered Copernican planetary system in the 1600’s, astronomers were faced with the question of the size of the solar system.   Using observations of Tycho Brahe, Johannes Kepler was able to determine the relative sizes of the orbits of the planets in terms of the distance from the earth to the sun, the Astronomical Unit.  These values are shown in the table below.  
	RELATIVE SIZE OF PLANETARY ORBITS

	Planet
	Semimajor Axis of Orbit (AU)

	Mercury
	0.39
	

	Venus
	0.72
	

	Earth
	1.00
	

	Mars
	1.52
	

	Jupiter
	5.20
	

	Saturn
	9.54
	


Even though Kepler had calculated the relative scale of the solar system quite accurately, astronomers in those days did not have an accurate measure of the absolute size of the solar system, in other words the true number of miles in an Astronomical Unit.  Most educated guesses in the 16th and 17th Centuries put the Astronomical Unit at about 5 to 10 million miles, about 10 times too small.  (The accepted value of the Astronomical Unit today is about 93 million miles or,  more precisely: 1.4959787 x 108 km = 9.2295578 x 107 mi.).   
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In 1715, Edmund Halley (of Halley’s comet fame), first proposed a workable method of determining the Astronomical Unit using observations of transits of Venus.   Halley’s method involved a time-honored way to measure distances using simple trigonometry.  If two observers at different locations on the earth could simultaneously view Venus as it passed in front of the sun, a northern observer would see the planet shifted to the south on the face of the sun with respect to what a southern observer would see. This shift, called parallax, depends on the distance between the two observers on the earth.  If the parallax, Θ, is measured, and the baseline or distance B, that is the distance between the two observers,  is known, then a simple trigonometric formula gives the distance between the earth and Venus, as shown in Figure 3 below.  Once the distance to Venus is known, the length of the Astronomical Unit can be found, since the distances between the sun and Venus and between the earth and Venus in Astronomical Units are known. 
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Though this was the basic principle involved, the details of Halley’s method were a bit more complex, because he realized that to use the parallax method the two observers would have to observe the transit at exactly the same moment, and in those days there were no clocks that kept time accurately enough to guarantee that the two observations were synchronized.  (Keeping clocks synchronized was especially difficult during long sea voyages, such as those necessary to observe the transit from different parts of the Earth.)  Halley’s solution was to realize that the observers at different locations would not only see Venus crossing the sun along different tracks, but that the total duration of the transit, from the first time that the silhouette of Venus appeared on one side of the sun until it disappeared off the other, would depend on the track.  If Venus appeared to cross near the center of the sun, it would take longer than if it appeared near the edge.  So different observers across the globe only had  to record the total duration of the transit, and from that they could determine just where Venus had appeared to track across the sun.  By comparing these tracks for different observers, they could then determine the angular shift between the tracks, Θ, and thus the length of the Astronomical Unit. 

Though Halley died in 1742 without ever seeing a transit, his method appeared so promising that astronomers began to prepare to observe the track of Venus across the sun at transits in 1761 and 1769.  Figure 4 below shows astronomers’ predictions of how the 1761 transit should appear at several sites, among them London (the bottom line), the mouth of the Ganges River in India (the middle line), and Bencoolen, in Malaysia (the top line).   
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Britain and France sent major expeditions to observe the transits of 1761 and the transit of 1769.  Captain James Cook’s famous first voyage to the South Pacific was undertaken to observe the 1769 transit of Venus from Tahiti.   Although many of the observers had good weather during the transit, and though many measurements were taken, the results of these elaborate observations were somewhat disappointing.   The principal problem was that it was very difficult to determine the exact time when Venus touched the sun at the beginning of the transit, and equally difficult to determine the exact time when it left the sun at the end.  Observers reported that, as Venus came close to the edge of the sun, its dark silhouette would seem to expand like a drop of water pulling away from a surface.  (Figure 5) This “black drop effect” made it difficult for observers to time the duration of the transit accurately enough to get really precise values of the size of the Astronomical Unit.  The best calculations from the observations in the 1700’s put it between 92 and 95 million miles. 
There were two transits again in the 19th century, in 1874 and 1882, and even more elaborate preparations were made to observe the track of Venus across the sun. The United States, Britain, France, Italy, Russia, Holland, and Denmark all mounted expeditions.  Technology had advanced by this time, and astronomers used photographs to record the position of Venus more precisely than they had been able to a century earlier.  But again the results were not as good as hoped for; precise timing of the duration of the transit just was too hard to attain. 
There were no transits of Venus in the 20th century, but by the time of the next transit, on June 8, 2004, Halley’s transit method had been superseded by several better and more precise methods of measuring the length of the Astronomical Unit, and the size of the solar system was known within a fraction of a percent error.   Nevertheless transits remain of great interest, both as rare and beautiful manifestations of the movements of objects in the solar system and as opportunities to apply modern technology to classic methods of astronomy—let us do just that in the exercise that follows.
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Making Observations of Transits using Modern Technology
Observing transits of Venus is no longer the preferred method for determining the size of the Astronomical Unit, but modern technology has made it easy to carry out this classic experiment again.  Using data from the 21st Century, we can achieve results that compare favorably of with those of the elaborate expeditions of the 1700’s and 1800’s.   The ease of the method nowadays a consequence of the fact that it is a simple matter to record digital images of the sun as Venus passes across it. These images can be stored, transmitted over the web, and measured to high precision using computers.   Even more important, we can now keep global time far more precisely than was possible in past centuries.  GPS receivers and the internet make it possible to synchronize clocks to within a small fraction of a second---so it is no longer necessary to measure the exact durations of the transits and then perform complex calculations to determine the different tracks of Venus across the sun as seen from two sites. Two images taken at exactly the same time---as measured by precisely synchronized clocks---will yield the parallax shift of Venus quite nicely. 
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What is even more convenient, however, is that we no longer have to travel around the world to set up observing sites in advance of the transit---the telescopes are already in place, pointed at the sun, snapping pictures even as you read this manual.  In 1995 astronomers at the National Solar Observatory completed the construction of a global network of telescopes designed to study the sun continuously. The six telescopes in the network are located in Big Bear, California; Mauna Loa, Hawaii; Learmonth, Australia; Udaipur, India; El Teide, Tenerife (The Canary Islands), and Cerro Tololo, Chile. The telescopes are operated by the Global Oscillation Network Group (GONG) based in Tucson, Arizona.  Because the Sun is so bright, the telescopes are small, and can be housed in modular trailers, not in the large domes used for telescopes that look at the stars (Figure 7).  At least one of the GONG telescopes is looking at the sun at any given time--check out the GONG website at http://gong.nso.edu for details about GONG and its telescope sites. 
During the transit of June 8, 2004, three of the GONG telescopes were able to observe the passage of Venus across the face of the sun---the ones in Tenerife, India, and Australia   The locations of these three sites, arranged from the northernmost to the southernmost, are given on Table 1, and their locations are shown on the map in Figure 8, below. 

	TABLE 1: GONG TELESCOPES OBSERVING THE TRANSIT OF VENUS, JUNE 8, 2004

	Site
	Latitude
	Longitude

	Observatorio del Teide, Tenerife, Spain
	+28˚17.5’
	-16˚29.8’

	Udaipur Solar Observatory, India
	+24˚ 35.1’
	+73˚42.8’

	Learmonth Solar Observatory

Australia
	-22˚13.2’
	+114˚6.1’
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 The data for the CLEA Transit of Venus exercise consists of three series of images taken with these telescopes on June 8, 2004:

54 images from El Teide between 7:05 and 11:35 Universal Time
39 images from Udaipur between 5:15 and 10:50 Universal Time

36 images from Learmonth between 5:00 and 8:50 Universal Time

Although images are acquired once per minute while the Sun is up at each of the GONG solar telescopes (averaging a total of about 3600 images per day!), the database for this lab includes images that were taken every 5 to 8 minutes on average, which is sufficient for determining the path of Venus across the sun.  Two sample images from this set are shown in Figure 9 below. 
A note about the images: The original images from the GONG telescopes have been processed to remove artifacts from the CCD cameras, to make the images uniform in brightness, and to orient all of the images in the same direction.  Other than that, the images in this exercise retain the high fidelity of the originals.  The images are 860 x 860 pixels in size, and oriented so that north is up and west is to the right, the same as we see the sun in the sky.  The solar disk is about 720 pixels across on each image and each pixel corresponds to 2.5 arcseconds. Venus moves across the sun from east to west (left to right) during the transit. The shift we expect to see in the position of the silhouette of Venus between the various observing sites is only a few pixels, but it is easily measured on these digital images using the software provided in this exercise. 
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Basic Strategy: Using the GONG Images of the Transit.

The CLEA software associated with this exercise allows you to display images of the Sun from the GONG solar telescopes and to measure the positions of the silhouette of a transiting planet.  The software details will be described later, but the basic idea of the scientific problem you will be investigating can be understood even before you get into the details of the software.

Your primary task is to compare the tracks of Venus across the sun as seen from a pair of GONG telescopes at two different observing sites and determine the angular shift or parallax, πm , in seconds of arc, between the two tracks at one particular time.   From the value of that angular shift, and the known distance between the two sites, you can then determine the distance between the earth and Venus.  The basic data are the images from the GONG telescopes. From them, you plot two tracks, and from the plot you measure the angular shift.  A sketch of the two tracks and the angular distance you will be measuring is shown in Figure 10. 
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Here are some questions you should ask yourself, and which you should try to answer when looking at the images:

· If one observing site is further north on the earth than the other, which transit track should appear the farthest north on the sun? Why?  
· Which transit track should appear the farthest south on the sun? 
· The observing sites also differ in that they are spread out east to west on the earth.  If observations of the silhouette of Venus are made at exactly the same time (UT) from all three sites, which site will see Venus further to the east on the sun? Which site will see Venus further to the west?
· Since there are three sites, how many parallax shifts could you measure from the data?  Is it better to use just one, or to measure all of them and take an average? 
CALCULATING THE ASTRONOMICAL UNIT FROM THE MEASURED PARALLAX OF VENUS 

You have measured a parallax πm from your observations of the transit from any two sites.  (Be sure to express this in arc seconds.  If your value of the parallax is in fractions of the radius of the sun, be sure to multiply it by the number of arc seconds in the radius of the sun)  


In addition to the measurement of πm, there are a few quantities that you need to know in order to calculate the length of the Astronomical Unit The CLEA software will help provide them for you: 

· The baseline, B between the two sites in kilometers, measured in a direction perpendicular to the line of sight between the center of the earth and the sun.  The CLEA software includes a simple program that calculates this, given the Universal time of the observation, the celestial coordinates (right ascension and declination) of the sun, and the terrestrial coordinates (latitude and longitude) of the two observing sites. 

· The distance between the earth and Venus, Dev and the distance between the earth and the Sun, Des at the time of the eclipse, expressed in Astronomical Units (you don’t yet know what the absolute value of the Astronomical Unit is, but you do know the relative distances in the solar system in AU.)

The simple formula you use to calculate the length of the Astronomical Unit A in km is:

A=   B • (Des -  Dev) • 206265
            πm• Dev• Des
CAUTION: Be sure your units are correct before you plug into this formula. B is in km, Dev and Des are both in AU, and πm is in arc seconds!
OPTIONAL: You do not need to know where this formula comes from in order to use it, but we describe its derivation in Appendix A on page 23.

Here is a summary of what you will be doing:

OBSERVATIONAL DATA (what you measure or are given):

· The parallax of the silhouette of Venus as seen at a particular time from two sites

· Determined from plotting the positions of Venus on two series of GONG images

· The baseline between the two sites 

· Determined by knowing the latitude and longitude of the sites and the particular time of the observation (which determines the direction to the sun.)
· The distance between the earth and Venus and the earth and the sun in Astronomical Units at the particular time of the observation, which is known from Newton’s laws.
WHAT YOU CALCULATE FROM THIS:
· The length of the Astronomical Unit in kilometers.
Equipment
This experiment requires a Windows-based computer (at least 512 MB of Memory is advised, and more is desirable, to display all the images), the CLEA program Transits of Venus and Mercury, and a scientific calculator.  (Note that modern computers usually provide such a calculator.)  You may also find it useful, but not essential, to use a spreadsheet and/or graph paper. 
A User’s guide to Transits of Venus and Mercury
A Program for Displaying and Measuring Transits Across the Sun
Starting the Program

Your computer should be turned on and running Windows. Your instructor will tell you how to find the icon or menu bar for starting the Transits of Venus and Mercury exercise. Position the mouse over the icon or menu bar and click to start the program. When the program starts, the CLEA logo should appear in a window on your screen. Go to the File menu at the top of that window, click on it, and select the Login option from the menu. Fill in the form that appears with your name (and partner’s name, if applicable). Do not use punctuation marks. Press “Tab” to move to the next text block, or click in each text block to enter the next name. Next enter the Laboratory table number or letter if it is not already filled in for you. Click in appropriate field to correct any errors. When all the information has been entered to your satisfaction, click OK to continue, and click “yes” when asked if you are finished logging in. The opening screen of the Transits of Venus and Mercury lab will then appear. 

Accessing the HELP Files
You may, at any time, select Help from the menu to receive on-line help. Click Help located on the right hand side of the menu bar. Within Help…Topics, there are seven  options that you can select: Log In, Run the Exercise, Image Database, Loaded Image List, Measurement Data, Analyze Measurement, and Close the Program. LogIn informs you of the initial steps required to begin the program. Files provides information on the types of files used in this exercise. Run The Exercise describes how to select a an exercise, usually based on data from the 2004 Transit of Venus.  Your instructor may also have you do an alternate exercise based on data from the 2003 Transit of Mercury.  Image Database explains how to retrieve images. Loaded Image List describes how to display images, make measurements on images, print images, and perform other related operations. Measurement Data shows you how you can review your recorded data, which will consist of tables of the positions of the silhouette of the transiting planet at specific times. Analyze Measurement describes how to display your measured tracks graphically, and how to derive the parallax and other information from them. Close the Program gives the procedure on how to exit the program as well as a reminder of any unsaved data. The Help menu also has an item that will call up the CLEA or GONG websites, and an item, About This Exercise,  that displays the title and version number of the program as well as the copyright information. 
Choosing an Exercise to Run
You will first choose Run the Exercise from the File menu. Normally your first choice will be the data on the 2004 Venus Transit.  Your instructor may also have you do an alternate exercise based on data from the 2003 Transit of Mercury.  

Loading and Displaying Images

When you first run the program you will see a Main File List area with two frames, the left labeled Loaded Image List and the right labeled Image Database Directory.   Both will be blank.  By using the File menu, you can load a database of images taken during the transit from one of the three observing sites (double click with the left mouse button on your choice of site).  After you load the image database from the File menu, you will see a list of the available GONG images, ordered by Universal Time of the image, in the Image Database window.  Images can be selected singly or the entire set can be selected.  You can load and display an image in one of two ways.  You can right-click on the image data box which will give you a set of selection and display choices.  Or you can use the File menu.  Once you load an image, its date is also displayed in the list of Loaded Images.  The last-selected image is automatically displayed in a large popup Image Display Window.   (See Figure 11, below)
For this exercise we suggest you “select all images” and then load them.  It may take a minute or so for them all to load, and while they are loading you will see them appear one by one in a display window on your screen while a window displays the progress of the load (the percentage of files loaded).   When all files have loaded, click the OK button on the window which has been listing the progress of the load.
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You can display any of the images in the Loaded Image List window by double clicking on the image time.   (You can also use the right mouse button to bring up a pop-up menu that will allow you to display the image, remove it, or remove all the images currently loaded) .
Animating a Series of images
Once you have a series of images loaded, you can have the program display each one in sequence automatically as an animation. This is a nice way to watch the entire transit in “fast motion”.  You can do this in either of two ways. On the main menu bar over the list of images, select the Images option, then select Animation.  Or on the menu bar over the Image Display window, select Animation---On.  The rate of the animation (how long it displays each image) can also be set from this menu bar.  You can stop the animation using the same menu bars. 
Measuring the Positions of the Silhouette of the Transiting Planet
The most notable feature on all the images is the silhouette of Venus or Mercury (except for those near the very beginning or end of a series, when the planet has not yet moved in front of the sun).   In order to plot the track of the planet across the sun you need to measure the position of this silhouette on every image of the series.  It’s a bit tedious, but the software makes it very easy. 

The image display permits you to measure the positions of points on the image, and it will automatically measure the coordinates of the center of the silhouette.   To start measuring silhouette positions, start at the top of the Loaded Image List, and by left clicking on each image date one by one, find the first one on which the entire silhouette appears. (The first few may not show the silhouette, or may only show part of it). 

To measure you need only left click on the displayed image, or you can choose File---Image---Measure from the menu bar at the top of the image display.  A small window will appear with digits to indicate the position of the cursor in pixels and in solar radii (fractions of the apparent radius of the sun). The position of the cursor is updated whenever you click the left mouse button, or continuously if you hold the button down.   You will also see a small magnification window that shows the area around the cursor. (see figure 12).  Pixels are of course just the little blocks that make up the picture, and pixel 0,0 is right in the center of the image. 
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Figure 12: Measuring the positions of silhouettes on the images.
Recording Data
When you are measuring silhouette  positions, there will be a small window on the screen (usually at the lower left) labeled Measurement Data.  When you click the “record” button, the image date and time and the position of the cursor are written to a data file, and the square around the image of the planet turns from red to green. If your instructor has turned on the “automatic centroiding” feature, which is usually the case, the software will calculate the precise center of the silhouette beneath the cursor when you click the right mouse button. ( If the automatic centroiding feature is not turned on, place the cursor as close to the center of the spot as possible before recording the position. )   The small magnification window helps by giving a magnified view of where the cursor is pointing, and the amount of magnification can be set, if desired, using a menu on the magnification window. The computer remembers whether you’ve measured a particular image, and will not let you measure it twice. (But see the next section to find out how to delete erroneous data).
 
[image: image10]
Seeing Tables and Plots of Recorded Data

At any time after you have some data recorded, you can view all the recorded data in a separate Transit Measurements window.  To do this, go back to the Main File List window and choose File---Measurement Data from the main menu bar.  There are choices that let you view the current data, or load a file of previously saved data.   If you choose to view the list, you will see the data window appear on the screen. (see Figure 13 above). The columns are labeled; the observing site is at the top, and the x and y position of the center of the planet on each image is given in units of fractions of a solar radius .  In addition to the date and time of the observation, the window will list the Julian Date of the observation, which is a running day number and fraction that is convenient for keeping track of astronomical times.  Instead of having to remember the number of days in a particular month when subtracting one date from another, you simply subtract one Julian Date number from another to get the number of days between two observations. A Julian Date begins at Noon, Universal Time; 0.5 day, of course, is 12 hours; each 0.0001 day is about 8 seconds. 

You can print the data in the Transit Measurements window by choosing List---Print from the menu bar.   You cannot edit individual measurements, since they were made automatically when you clicked on the image on a picture; but if an entry seems to be in error, you can delete it by selecting the line (with a left click of the mouse), and using the Edit menu on the menu bar to select Delete Selected Line. 

It is also possible to view the measurements you are making in graphical form, against a circular image of the sun.   Simply drag on the Analysis  item menu bar on the main window and select Plot/Fit Data.  A window will open showing a plot showing your position measurements as small circles, connected by straight lines to represent the track of the planet across the face of the sun.  The View choice on the menu bar of this window will allow you to see the track on the scale of the whole sun, or a magnified view. The magnified view is especially useful when comparing the tracks as seen from two or three sites, because the difference between the tracks is small and can best be seen when magnified. 
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Saving Data
When you have completed measuring all the positions from a particular GONG site, save the data; you may, in fact want to save the data even before you have finished from the site just to guard against loss.  Simply use the File—Measurement Data—Save Data menu on the mail window and give the file a name. Then if you make a mistake or the computer system crashes, you can retrieve the data without having to remeasure it.  

Measuring tracks from a second and third site

You will want to measure the transit tracks from all three sites. To view the images from another site, just go back to the main window, File --- Image Database---Image Directory---Load choice and double click on the listing for a different site.  Select all the images from this site, and display and measure as you did for the first. Data will be added to the same data list you started for the first site, with new entries labeled as being from the second site.  And you can now view the plots of both tracks on the graphical display window, either on the scale of the full solar disk or as magnified “detail” view. 
Measuring the Parallax between the tracks and Computing baseline and Distance Data.
Once you have measured the tracks of the transit from at least two sites, you are ready to measure the parallax of Venus as seen from the two sites.   Basically, all you need to do is select a time when Venus was visible from both sites, and the computer will compute the angular difference between the two tracks.  If it is not already open, open the Analysis---Plot/Fit Data  window.  Then on the plot window select View---Detail so you can see the plots more easily.  The computer connects your measured observations from a given site with a line to produce a track across the sun from each site---you can select either best fit straight lines or a parabola (quadratic) using the Data---Fit menu on the plot window.  Then select a time to calculate the parallax by using the Data---Select Observation time menu item.  A slider will appear at the bottom of the screen, and as you move it back and forth you can see somewhat larger circles appear on the tracks which mark the position of the silhouette of the planet as seen from each site.  Pick a time in the middle of the observation period when the planet is visible from all the sites.   

[image: image12]
Once the observation time has been set, a you can now read out all the information you need  simply use the Data---Sun,Planet,Baseline Data  choice on the plot window, and you will get a window called the Transit Analysis Ephemeris and Baseline Report  listing all the information you need to insert into the formula for the Astronomical Unit on page 12.  That information is:

· The “Measured Parallax” in solar radii at the time of observation, which is essentially the distance between selected tracks as seen from a particular two sites.  You will need to convert that into seconds of arc using:

· The apparent diameter of the sun at the time of the observation, measured in arcseconds (this is twice the solar radius, of course).

· The distance from the earth to Venus, Dev at the time of observation, in AU.
· The distance from the earth to the sun, Des at the time of observation, in AU.

· The “Projected Baseline”, the distance between the two sites perpendicular to the direction to the sun, measured in km (note that miles are also given, but you want km).

· There is also additional information used by the computer, but that you don’t need, such as the coordinates of the center of the sun and the planet, the apparent diameter  of Venus, and the latitude and longitude of the observing sites. 

At this point you can print out the data on the report form using the List---Print menu choice on the Transit report window.   The data can then be inserted into the equation for the Astronomical Unit on page 12, and the length of the Astronomical Unit calculated. 
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The Length of the Astronomical Unit Using GONG Images of the  June 8, 2004 Transit of Venus
 Discovery-Based Procedure
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tc "Procedure"
There are numerous ways in which you can use this program to determine the length of the Astronomical Unit.  Your instructor may provide you with a detailed procedure for this exercise, or may simply ask you to experiment with the program to discover your own method for determining the length of the Astronomical Unit.  The user’s guide on the previous pages is only a guide, not a prescription. Experiment with the program. Try discovering some of its possibilities by trial and error, and by reading the help screens for the program.  Ask your instructor as questions arise.
The Problem:
To determine an accurate value for the length of the Astronomical Unit using images of the Transit of Venus of June 8, 2004 seen from three different sites on earth.

Resources:tc ""
1) Images from the GONG telescopes.

2) CLEA Software for displaying and measuring the position of Venus on the GONG images.

3) Other software, calculators, and reference works you choose to use. 

4) Your instructors and lab partners who are available for discussion and help.

Report Format options

1) Raw data and brief analysis:

Submit the following data stapled together:

· Print outs of sample data

· Table of measurements

· Plots used to derive results.

· An outline of the procedure used to measure and analyze the data.

· A sheet containing formulas used and sample calculations used in the experiment.

· A paragraph or two stating the final result.
2) Journal Article format:

The report should describe what you did, what you recorded, how you analyzed the data, and what you concluded.  Be brief---you don’t need to write down every mouse click you made. But be clear, so that if someone unfamiliar with the experiment were to read it, that person could understand just what you did and why.  Include the following sections:

· Introduction describing the background and motivation for the work.
· Data and basic measurements, including, if applicable
· A sample image.
· Printout of data tables
· A brief description of what measurements you made and how you made them.
· Plots and analysis
· Any graphs you used.
· Description of the method used to turn the raw data  (e.g. Venus positions) into desired results;  Describe the logic of the method and show the formulas used in any calculations.
· Tables of calculated data if more than one number was calculated, or if several numbers were averaged together.
· Summary and conclusions: State what you did and what the important results were.
Extra Credit Project: Calculating the Astronomical Unit using GONG Images of The Transit of Mercury, May 7, 2003 
A transit of Mercury, which is even closer to the sun than Venus, occurred on May 7.2003.   The GONG telescopes, as usual, were observing  the sun.  Three sets of images for the transit are available by choosing the File---Run---2003 Mercury Transit option when you first run the software.  
The data for the CLEA Transit of Mercury exercise consists of three series of images taken with these telescopes on May 7, 2003:

10 images from El Teide between 7:20 and 8:15 Universal Time

70 images from Udaipur between 5:10 and 10:55 Universal Time

10 images from Learmonth between 6:40 and 7:30 Universal Time

You can use the same procedure you used for the Venus transit to derive the length of the Astronomical Unit from the Mercury transit.  Do that, and compare the two values.  Here are some questions to consider:

· Before you begin, do you think that the Mercury transit will yield more precise results?  Why or Why not? 

· What complications are there compared to the Venus data? How do the size of the Mercury silhouettes compare to those of Venus? How do the size of the observed parallax shifts compare? 

· Look at the timing of the data.  There are very few times when the transit was visible from all three sites, as opposed to the Venus data. How might this affect the precision of your results? 
· Transits of Mercury are more common by far than transits of Venus---there were 14 Mercury transits in the 20th century and there will be 14 in the 21st century, while there were NO Venus transits in the 20th Century and only 2 in the 21st.

·   Why didn’t astronomers in the past use observations of Mercury transits to determine the length of the Astronomical Unit rather than relying on the very rare transits of Venus?

· What other planets transit the sun and could be usable to determine the length of the Astronomical Unit? 

· If you are interested in seeing another trigonometrical method astronomers use to determine the size of the Astronomical Unit, see Project CLEA’s exercise ASTROMETRY OF ASTEROIDS.
Appendix A:

Derivation of the formula for converting the measured parallax of Venus into the length of the Astronomical Unit [image: image15.jpg]



Figure 17
Refer to Figure 17 above.   The angular shift of the planet Venus one should see in moving a baseline distance B in km, from observatory a to observatory b, is just the ratio of the baseline to the distance to Venus,  DevA
πv = B/ DevA
where Dev is the distance between the Earth and Venus in Astronomical Units and A is the length of the Astronomical Unit in km. 
But the sun, which is a distance DesA away will appear to shift down, too, by an amount 
πs = B/ DesA
So what you actually measure, πm, when you observe the shift in position of the planet as seen from the two sites is the shift of the planet MINUS the shift of the sun. In other words: 

πm = (B/ DevA) – (B/ DesA)

The parallax angle given above must be in radians for the equation to work, but the radian is an awkward unit to use. If we measure the parallax in arcseconds the measured angle needs to be converted to radians by dividing by 206265, which is the number of arcseconds in a radian.  Dividing  πm above  by 206265 and rearranging to solve for A yields the formula we used to calculate the Astronomical Unit from the observed parallax: 

A   =     B  • (Des -  Dev)•206265
            πm • Dev • Des
APPENDIX B
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APPENDIX C:

Using the Transit of Venus to Determine the Length of the Astronomical Unit: Step-by-Step Proceduretc "Procedure"
1) Run the CLEA Transits of Venus and Mercury software. Log in.  Choose File---Run---2004 Venus Transit and the main data window will appear.  
2) Choose File---Image Database---Image Directory---Load , and you will see a list of the three GONG observatories that took images of the Transit.  We will measure the data from each of these, but let’s choose the data from Learmonth first.  Double click on the entry for this observatory,  and a list of all the images from this site will be loaded into the Image Database Directory column of the main data window Scroll down the window to see what times are available.

All the images were taken between these times on June 8, 2005: 
Site: LEARMONTH , Images between _______ and ______UT.
4) Select all the images by right-clicking on the Database Directory and choosing Select All.  Load all these images into the computer by right clicking again and choosing Load Selected Images.  An image window will open showing each image as it’s loaded in. When all the images have loaded you can, if you want, see an animation of the series of images, showing the planet Venus moving across the sun, by using the Animation---On menu on the image window. Animation---Off will stop the animation.  The animation can be speeded up by changing the Animation---Set Rate menu item. 
5)  You will now measure the position of Venus on each image. To see the first image in the series, make sure the animation is not running (see above), and then go to the top of the Loaded Image List, the right column of the main screen, and right click on it.   Venus may not appear on the first few images, so go down through the list until you find the first images where Venus begins to poke on to the edge of the sun. Continue down the list until you find the image where the complete silhouette of Venus can be seen. This is the first one you will measure. Record the time that this image was taken at.

First measureable image from LEARMONTH was taken at ______________UT

6) Next you will begin to measure the positions of Venus on the images. Simply position your cursor over the silhouette of Venus and right double click.  A window opens showing a magnified image of Venus, and it will automatically center on the planet. Another window opens at the top to show the x and y coordinates of the center in units both of pixels and of fractions of a solar radius.   A “measurement data” window will open at the bottom of the screen, showing the same coordinates, time, and information on the observing site.  Very important: Click the “record” button to add this data to the list of measurements the computer is keeping for you.  If you don’t do this, you will not be able to analyze or print out your measurements later. 
7) Continue on  in this fashion through each image taken from Learmonth until all the measurements have been recorded.  The software keeps track of which images you have measured,  and won’t let you record twice (it “grays” out the record button on previously measured images and turns the box around the planet from red to green) so don’t worry about measuring the same image twice. If you measure one incorrectly or leave one out, don’t worry. Data can be deleted later, and one or two missing image measurements won’t affect your final result.
8) When you have finished measuring and recording all the positions from the Learmonth images, save your data. To do this, go back to the main screen, choose the File---Measurement Data---Save Data option, give your file a distinctive name (such as your initals or last name), and save it.  Record the name here


Name of Data file ______________________________.
9) If you want, you can view the data you’ve recorded already by choosing (from the main window) File---Measurement Data---View/Edit, which will show you a text window with what you’ve recorded so far (you will later print this out, when all the data is taken).  You can also view a graph of your data against a circle representing the sun by choosing Analysis---Plot/Fit Data.   The graphical window that appears will later be used, when you have all your data, for determining the parallax of Venus.   Close these windows before proceeding.
10) Now proceed, following the steps 2-7 above, to load in the images from the next GONG site, Udaipur, measure and record the positions of Venus on each of them, and save the results (they all go on to the same data file; you don’t have to change the name).  

11) When you have finished measuring the images from Udaipur, do the same for the images from El Teide. Note that the last few images from this site will not show complete silhouettes of Venus, so you shouldn’t measure them.  Again, Don’t forget to save the data!  
12)   When you have collected all the data, you will next want to print the measurements you have made, just for the record. From the main menu choose File---Measurement Data---View/Edit and a window will open with the list of your Venus transit measurements.   Choose List----Print on this window, and the list of your measurements will print out.  Close the window when you’re done.
13) You now want to view and analyze the three tracks.  To do this, from the main menu choose the Analysis---Plot/Fit Data and you should see the three tracks plotted against a circle representing the sun. Note that they are very close together. The parallax of Venus is quite small. But you can view it in more detail by choosing View---Detail from the plot window menu.   Note that the three tracks are now well separated.  The circles represent the measurements you have recorded. You will want to print out this window, using the View---Print Window menu choice.   In the space provided on the next page, explain why these three tracks are in the order you see them: Why is the Learmonth track at the top, and the El Teide track at the bottom?  ( a diagram may help). 
Answer here:

14) The points you have measured should appear to be connected by straight lines, which gives a jagged appearance to the tracks.  Next we need to fit a single line to each track, smoothing out experimental imprecisions.  Choose the Data---Curve Fit---Quadratic  menu option, and you will see single slightly curved lines fit to the data. 

15) The shift, or parallax of Venus, πm , between any two tracks is what we use to determine the length of the Astronomical Unit.  It can be measured at any time during the transit, but we will want to measure all three shifts between the three combinations of the three sites (Udaipur vs El Teide, Udaipur vs Learmonth, and Learmonth vs El Teide), so we need to choose a time when the transit is visible from all three sites. To do this, choose Data----Select Observation Time and a slider will appear below the plot.  If you slide it back and forth, you will see three circles appear on the tracks that represent the positions of Venus as seen from the three sites at the time set on the slider.  Find a time when the transit is visible from all three sites.  Click OK to set that time into the computer.  A small window opens at the top of the page recording the time and the parallaxes as seen between the three pairs of sites the units of parallax will be in fractions of a solar radius, and will later have to be converted into arc seconds. Record that data  on the table below:
	OBSERVATION TIME (UT):

	Site
	Parallax (Solar Radii)

	Parallax of El Teide-Udaipur (solar radii)
	

	Parallax of El Teide-Learmonth (solar radii)
	

	Parallax of Udaipur-Learmonth (solar radii)
	


16) We need additional information to use in the formula on page 12 for the length of the Astronomical Unit: the “projected baseline” between any two sites, the distance to the sun and Venus in Astronomical Units, and the angular size of the sun (to convert the parallaxes to arc seconds.

The computer calculates this information once the observing time is selected.  Simply choose Data---Sun, Planet, Baseline Data from the plot display window, and another window will open up with all this data. Choose List---Print on this window to print out the data.   You should now be able to use the data from that table (not all the data it prints out is needed), to fill in the table on the next page, which is what you will need to calculate the Astronomical Unit using the formula from page 12
A=   B • (Des -  Dev) • 206265

πm• Dev• Des

CAUTION: Be sure your units are correct before you plug into this formula. B is in km, Dev and Des are both in AU, and πm is in seconds of arc!
	DATA TABLE FOR CALCULATING THE LENGTH OF THE ASTRONOMICAL UNIT


	DATE AND TIME OF OBSERVATION (UT)
	

	DISTANCE OF SUN, Des (A.U.)
	

	DISTANCE OF VENUS, Dev (A.U.)
	

	Apparent Diameter of Sun (arc seconds)
	
	Apparent Radius of Sun (arc seconds)=Diameter/2
	

	El Teide-Udaipur
	El Teide-Learmonth
	Udaipur-Learmonth

	Projected Baseline (km)
	Projected Baseline (km)
	Projected Baseline (km)

	
	
	

	Measured Parallax πm (arcseconds)
	Measured Parallax πm (arcseconds)
	Measured Parallax πm (arcseconds)

	
	
	

	
	
	


17) Now use the data from the table above to calculate the length of the Astronomical Unit using the parallax from each of the three pairs of observing sites and the formula from page 12.  Also calculate the average value and enter it in the table below.
	THE LENGTH OF THE ASTRONOMICAL UNIT DETERMINED FROM TRANSIT OBSERVATIONS (km)

	El Teide-Udaipur
	

	El Teide-Learmonth
	

	Udaipur-Learmonth
	

	AVERAGE FROM THREE SITES
	


QUESTIONS TO CONSIDER:

1) What is the percentage difference between your answer and the currently accepted value of the Astronomical Unit?  
2) Transits of Mercury occur more frequently than Transits of Venus.  How do you think an transit of Mercury might appear different? Why weren’t transits of Mercury used to determine the length of the AU? Why might it be harder to get a good value from observations of the Transits of Mercury? 
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Figure 1: The first observations of a transit of Venus as sketched by English astronomer Jeremiah Horrocks on December 4, 1639
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Figure 10: The tracks of Venus across the sun as seen from two sites.   Also shown are the appearance of the silhouette of Venus from the two sites as seen at the same time, and the observed parallax of Venus, πm .





Figure 8: Sites of GONG Telescopes that Observed the Transit of Venus, June 8, 2004
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Figure 7: Telescopes operated by the Gong Project
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Figure 9: Two typical images of the Sun from GONG showing both the sun and the silhouettes of Venus as it transited from east to west across the sun on June 8, 2004 . Arrows have been added to indicate directions on the sky.
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Figure 11: Main window and image display window. 
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Figure 14: Graphical plots of measurements show the track of the planet across the sun.


On  the left is a full disk view; on the right, the magnified view.
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Figure 13 : Recorded data listings.
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Figure 16: Report windows showing data derived from the observed tracks of Venus across the sun.
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Figure 15: Selecting the observation time with a slider
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Figure 2: Edmund Halley





Figure 3: Halley’s Method





�








Figure 4: Predictions of the Transit of Venus of 1761 made by James Ferguson,





�





Figure 5: Observations of the 1769 transit of Venus by Captain Cook, showing the “black drop” effect that made timing difficult.





Figure 6: The 1874 Transit observed from Sydney Australia
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